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Renesas Synergy™ Platform 

Creating a Custom Board Support Package for SSP 
v1.2.0 or Later  
Introduction 
This document provides different approaches to create a new custom board support pack (BSP) for Renesas 
Synergy Software Package (SSP) v1.2.0 and later. A new pack can be created for SSP v1.2.0 or later, either 
by using a built-in Synergy Pack Exporter, or by directly working on the files of a pack folder. 

Goals and Objectives  
The objective of this document is to demonstrate different approaches to creating a custom BSP for the SSP 
v1.2.0 or later, which is used along with the e2 studio ISDE (v5.3.1.x or later) or the IAR Embedded 
Workbench for Renesas Synergy™ (IAR EW for Synergy) (v7.71.1.x or later). 

Prerequisites 
As the user of this application note, you are assumed to have some experience with the Synergy SSP v1.2.0 
or later, and the supported Renesas e2 studio ISDE, or the IAR EW for Synergy. 

Required Resources 
To perform the procedures described in this application notes, you will need: 
 A PC running Microsoft® Windows® 7 or later with the following Renesas software installed:  

 e2 studio ISDE v5.3.1.002 or later 
 IAR EW for Synergy v7.71.1.x or later 
 Synergy Software Package (SSP) v1.2.0 or later 
 Synergy Standalone Configurator (SSC) 5.3.1.002 or later 
 A zip software utility supporting the compression method DEFLATE (like 7-Zip (https://www.7-zip.org/)  

You can download the required Renesas software and its supported packages from the Renesas Synergy 
Gallery (https://www.renesas.com/in/en/products/synergy.html). 
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1. Board Support Packs in SSP 
The Board Support Pack (BSP) is a subset of Synergy Software Package (SSP), and provides an interface 
for setting up the SSP to work with selected MCUs and specific board HW designs, making it both MCU and 
board specific. The BSPs created are available for the Renesas Synergy™ Starter/Development/Promotion 
boards, but users eventually must create new BSPs for implementing their final products. 

Synergy is CMSIS-compliant and is based on the CMSIS-core. Therefore, the board pack file structure is 
organized into folders containing the MCU, board-specific CMSIS information, and is represented as an 
XML-based pack description (PDSC) file as defined in the CMSIS standard (Keil, 2016). All these files are 
packed in a ZIP format (.zip). 

1.1 Pack File Structures in SSP Releases 
In earlier SSP releases (prior to SSP v1.2.0), specifications of MCUs and boards are packed into a single 
pack file, as shown in Figure 1, which restricted the capability of supporting different MCUs and boards. 

 

Figure 1.   Sample Snapshot of Default Packs Provided in SSP v1.1.3 
In SSP v1.2.0 and later, the pack files are classified into MCU specific, board specific categories, and even 
into some default application templates, making future upgrades and custom extensions more convenient. 

 

Figure 2.   Sample Snapshot of Default Pack Files Provided in SSP v1.2.0 and Later 
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1.2 BSP Contents in SSP v1.2.0 or Later 
Support information to be specified in a BSP is as follows: 

• A pin configuration file for the selected device 
• Two XML specification files for linking the selected device and expected board indicating their file 

locations 
• A set of drivers for the selected peripherals and pins. 
 
For example, Renesas.Synergy_board_s7g2_dk.1.2.0.pack has files as shown in Figure 3. 

 

Figure 3.   Board Support Information Contained in a BSP Pack (s7g2_dk.pack) 
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1.3 Creating a BSP in SSP v1.2.0 or Later 
Unlike the board pack files provided with the Synergy development or system kits, such as DK-S124 and SK-
S7G2, you must create a BSP pack for your custom boards.  

While copy/paste of files works to some extent, especially when using the IAR EW for Synergy 
(v7.71.1.11989), the creation of a custom BSP has been simplified with a built-in CMSIS-pack generator in 
e2 studio 5.3.1.002 or later, IAR EW for Synergy v8.21.1 or later, and SSP v1.2.0 or later. This document 
provides suggestions for selecting relevant workflows in creating a custom BSP. 

 

Figure 4.   Approaches to Creating a Custom Board Pack in SSP v1.2.0 or Later 

2. Custom BSP Files 
Figure 4 shows two approaches to creating a custom board pack, which can be described as follows: 
• Create a custom board pack based on an existing BSP by replacing existing files with your new board 

specification, and packing them with the built-in Export Synergy User Pack in e2 studio 5.3.1.002 or later 
and IAR EW for Synergy v8.21.1 or later. 

• Work on a selected BSP in the \internal\projectgen\arm\Packs folder of your SSP installation 
as part of e2 studio or IAR EWSYN, to manually modify or create related files in the custom pack, and 
generate a .zip format. 
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2.1 Creating a BSP using Export Synergy User Pack Provided in e2 studio v5.3.1 to 
v22.10.0 and IAR EWSYN v8.21.1 or Later 

To create a custom board pack in e2 studio environment: 

1. Create a new Synergy C Project, for example, S5D9_CB. 

 

Figure 5.   Creating a Project 

2. Click Next to select a board for your new project. 
3. Use the default SSP v1.2.0 or later. In the board pulldown menu, select an already created Synergy 

board with the same or similar device as your targeted MCU. For example, the S5D9 PK with 
R7FS5D97E3A01CFC is selected as a pack template. 

 

Figure 6.   Select an Existing Board with the Same Device as Your Board 
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4. Click Next to select a project template. 
5. Select the BSP in the Project Template Selection for this project, S5D9_CB. 
 

 

Figure 7.   Select the BSP As Your Project Template 

6. Click Finish. The default BSP files for S5D9-PK are generated automatically. In e2 studio, the project 
explorer shows all the files generated as shown in Figure 8. 

 

Figure 8.   Generated Board Files as Templates for Creating Custom Board Files 



Renesas Synergy™ Platform Creating a Custom Board Support 
Package for SSP v1.2.0 or Later 

R11AN0071EU0115  Rev.1.15  Page 7 of 28 
Aug.09.23  

In IAR EWSYN v8.21.1 or later, once SSC is closed, the project explorer shows the following generated 
files. It does not contain the pincfg file as shown in Figure 9. 

 

Figure 9.   Generated Board Files as Templates in IAR EWSYN 
The project in EWSYN workspace should also include the .pincfg file to create the custom bsp pack. 
To include the .pincfg file in the project, select Add Files option from the project menu and select 
S5D9-PK.pincfg file. 

 

Figure 10.   Adding Files to the Project in the EWSYN Workspace 

The file is now added to the project.  

 

Figure 11.   Project Files in IAR EWSYN After Adding the pinCfg File 
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7. Rename the S5D9-PK.pincfg to your custom pin configuration file, S5D9-CB.pincfg. 
8. In the Synergy configurator, change the pincfg file in the Pins tab from the pulldown menu. Select pin 

configuration, then select the S5D9_CB.pincfg configuration, and select Generate Data as 
g_bsp_pin_cfg. 

 

 

Figure 12.   Specify the Data Structure to Hold Your Pin Configuration 

9. Based on your board I/O schematics, create a new g_bsp_pin_cfg structure by deselecting the unused 
peripherals/ports, and select the required components on the custom board in the Synergy 
Configuration, Pins panel. For example, the custom board S5D9_CB has a high-speed USB host and a 
full-speed USB device as shown in Figure 13. 

 

Figure 13.   Set the Connection Between Pins and Peripherals on Your Board 

10. Click the Generate Project Content button to generate new Synergy files based on the configuration on 
each tab, such as Clocks, Pins, and so forth, and then save these generated configuration files. 
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11. On the project folder in your workspace, under module_description subfolder, use the default Windows 
search function to replace the original board name such as S5D9_PK with a new board name, which is 
S5D9_CB in the current project as shown in Figure 15. 

12. From e2 studio v7.3.0 or SSC 7.3.1 or later versions, module_description folder is available only at the 
application level. It is the modules (module_description in versions prior to e2 studio 7.3.0 ) directory 
within the SSP installation directory as shown in Figure 14. 

 

 

Figure 14.   Modules Folder in e2 studio v7.3.0 or Later  

Make a copy of the original board files of PK-S5D9 and rename them with the new board name as 
shown in Figure 15. 

 

Figure 15.   Replace the Existing BSP Name with Your BSP Name 
Note: The new board name, S5D9_CB is assigned to the Export Synergy User Pack window as shown in 

the step 11 or 12. Specifically, the macro BSP_BOARD_S5D9_PK should be replaced with 
BSP_BOARD_S5D9_CB in existing board files. 

 

Figure 16.   Replacing Template Board Name with Your Board Name in Generated Synergy Files 

13. Rename the folder (generic bsp folder to custom bsp folder, for example, s5d9_dk or s5d9_pk to 
s5d9_cb). 

14. Edit bsp_init.c to rename BSP_BOARD_S5D9_PK to BSP_BOARD_S5D9_CB and disable or 
delete the line bsp_qspi_init() as required by the project based on the drivers needed for the new 
BSP. 

15. Edit bsp.h and remove the line #include "../s5d9_cb/bsp_qspi.h. Rename 
BSP_BOARD_S5D9_PK to BSP_BOARD_S5D9_CB under macro definitions. 
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16. Delete driver files for unused peripherals, such as bsp_qspi.h/c, since no QSPI is selected in the 
pincfg. 

 

 

Figure 17.   Delete Files for Unused Components 

17. Based on your board layout, modify the board files to include GPIO driven components, such as LEDs, 
which are defined in the bsp_leds.c/h file: 
/**  Array  of  LED  IOPORT  pins.  */ 
static  const  ioport_port_pin_t  g_bsp_prv_leds[]  = 
{ 
 
              IOPORT_PORT_04_PIN_08,     ///<  LED1_R 
              IOPORT_PORT_04_PIN_09,     ///<  LED2_G 
}; 

18. Export the new board files with a build-in CMSIS-Pack generator.  
There are three ways to access the Export User Packet Wizard in e2 studio: 
A. Right-click the project, then run the operation  

B. Select the project, click File -> Export in e2 studio, then select   in the Export 
window, or  

C. Right-click on the project, and select the  menu item, then select the type of 
in the Export window. 

To access Export Synergy User Pack in IAR EWSYN v8.21.1 or later, select the option 
  in the Renesas Synergy menu. 

A dialog window is displayed after one of the above operations, as shown in the following figure. 
 

 

Figure 18.   Specify Vendor Information in the Synergy User Pack 
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Perform the following steps to create a custom board pack: 
A. Select Create a board pack. 
B. Set the location for the new pack, as per your e2 studio installation. In this example project, we have 

chosen C:\Renesas\e2_studio_531_120g\internal\projectgen\arm\packs. 
C. Fill out the Vendor, Name, and Version information, and click Next. 

This brings up the dialog in Figure 19. 

 

Figure 19.   Specify the Custom Board Information in the Synergy User Pack 

D. Fill out the Group name and Version. 
E. For Board name, enter S5D9_CB. 

Note: The board name must match the board folder name that you used in step 13. 

F. Click the Add button on the screen to select the files that you want to include in the pack. 
Note:  Make sure to include your pin configuration file and board source files. 

 

Figure 20.   Specify Files Included in the Synergy User Pack 
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G. Press OK and Finish to create the custom board pack, 
ZZ.Synergy_board_s5d9_cb.1.2.0.pack. 

 

Figure 21.   Location of a New Board Pack Created Successfully 

19. Test this custom BSP pack by creating a new project, selecting S5D9_CB from BSP the in e2 studio, and 
then making other Synergy configurations. 

 

Figure 22.   Select and Test Your Created Custom BSP Pack 

2.2 Creating a BSP using Export Synergy User Pack in e2 studio v23.7.0 or Later, 
and IAR EWSYN v8.21.1 or Later 

To create a custom board pack in e2 studio v23.7.0 environment or later, see the following steps:  

1. Create a new Synergy C Project. Click Next. 

 

Figure 23.   Creating a Project in e2 studio 
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2. Name the project as, for example, S5D9_CB. Then, click Next to select a board for your new project. 

 

Figure 24.   Name the New Project 

3. Use the default or latest SSP pack. In the board pulldown menu, select an already created Synergy 
board with the same or similar device as your targeted MCU. For example, select S5D9 PK with 
R7FS5D97E3A01CFC as a pack template. Click Next to select a project template. 

 

Figure 25.   Select an Existing Board with the Same Device as Your Board 
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4. Select BSP in the Project Template Selection for this project, S5D9_CB. 

 

Figure 26.   Select the BSP as Your Project Template 

5. Click Finish. The default BSP files for S5D9-PK are generated automatically. In e2 studio, the project 
explorer shows all the files generated as shown in the following figure. 

 

Figure 27.   Generated Board Files as Templates for Creating Custom Board Files 
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6. In the Synergy configurator, under Pins tab, click Manage configurations.... 

  

Figure 28.   Manage Configurations 

7. The following window pops up: 

  

Figure 29.   Rename Option for pincfg 

Select ”S5D9-PK.pincfg” and click Rename. 
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8. Rename it to the custom board, in the following example, ”S5D9-CB.pincfg”. Click OK. 

 

Figure 30.   Rename pincfg file for the Custom Board 
9. The renamed .pincfg file is reflected under Manage Pin Configurations. Click OK. 

 

Figure 31.   Custom Board pincfg File 
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10. The renamed .pincfg file will automatically be populated under Pin Configuration. 

 

Figure 32.   Pin Configuration Tab Showing the Custom New Board pincfg File 
11. Based on your board I/O schematics, create a new g_bsp_pin_cfg structure by deselecting the 

unused peripherals/ports, and select the required components on the custom board in the Synergy 
Configuration Pins panel. For example, the custom board S5D9_CB has a high-speed USB host and a 
full-speed USB device as shown below: 

  

Figure 33.   Set the Connection Between Pins and Peripherals for Your Board 
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12. Click Generate Project Content button and Proceed to generate new Synergy files based on the 
configuration on each tab, such as Clocks, Pins, and so forth, and then save these generated 
configuration files. 

 

Figure 34.   Generate the Project Content 

13. The modules folder used by e2 studio is stored in the support folder of e2 studio. The support folder 
can be opened by selecting Help > About e2 studio from the e2 studio menu and clicking the 
Installation Details > Support Folders > e2 studio support area link from the dialog box as shown 
below. 

 

 

Figure 35.   Support Folder in e2 studio 
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14. Open the modules folder by clicking the e2 studio support area” link and navigating to 
“internal\projectgen\arm” 

 

Figure 36.   Modules Folder in e2 studio v7.3.0 or Later 

15. Make a copy of the original board files of PK-S5D9 and rename them with the new board name as 
shown in the following figure. 

 

                                                                                            

 

Figure 37.   Replace the Existing BSP Name with Your Custom Board Name 

16. Rename the generic BSP folder to custom BSP folder, for example, s5d9_pk to s5d9_cb. 

 

Figure 38.   Renaming to Custom Board Folder 
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17. The macro “BSP_BOARD_S5D9_PK” should be replaced with “BSP_BOARD_S5D9_CB” in all existing 
board files. 

 

Figure 39.   Replacing Template Board Name with Your Board Name in Generated Synergy Files 
18. Delete the driver files for unused peripherals, for example, bsp_qspi.h/c, if no QSPI is selected in the 

pincfg. 
19. Based on your board layout, modify the board files to include GPIO driven components, such as LEDs, 

which are defined in the bsp_leds.c/h file: 
 

 

Figure 40.   Modify GPIO Driven Components  
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20. Export the new board files with a built-in CMSIS-Pack generator. There are three ways to access the 
Export Synergy User Pack Wizard in e2 studio: 

A. Right-click the project, click Export. 
B. Select the project, click File > Export in e2 studio. 

For both (A) and (B), the following window pops up: 

 

Figure 41.   Export Synergy User Pack Wizard 

Under General, select Renesas Synergy User Pack for proceeding with the further steps to create 
the custom BSP pack. 

C. Right-click on the project, select Renesas Synergy Export and then select Export Synergy User 
Pack... 

 

Figure 42.   Renesas Synergy Export Option 
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A dialog window is displayed after one of the above operations, as shown in the following figure: 

 

Figure 43.   Specify Vendor Information in the Synergy User Pack 

Perform the following steps to create a custom board pack:  
a. Select Create a board pack. 
b. Set the location for the new pack, as per your e2 studio installation. In this example project, we 

have chosen C:\Renesas\e2studio_2023_07\internal\projectgen\arm\packs. 
c. Fill out the Vendor, Name, and Version information, and click Next. 

This brings up the dialog box as shown below: 

 

Figure 44.   Specify the Custom Board Information in the Synergy User Pack 
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d. Fill out the Group, Subgroup, Version and Description. 
e. For Board name, enter S5D9_CB. 

Note: The board name must match the board folder name that you used in step 16. 

f. Click the Add button on the screen to select the files that you want to include in the pack. 
Note: Make sure to include all board source files. 

 

Figure 45.   Specify Files To be Included in the Synergy User Pack 

g. Press OK and Finish to create the custom board pack, 
ZZ.Synergy_board_s5d9_cb.2.4.0.pack. 

 

Figure 46.   New User Pack successfully created 
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21. Test this custom BSP pack by creating a new project, selecting S5D9_CB from BSP in the e2 studio, and 
then making other Synergy configurations. 

 

Figure 47.   Select and Test Your Created Custom BSP Pack 

2.3 Creating a Pack Based on an Existing Pack in SSP v1.2.0 or Later 
This example shows how to create a custom board pack in the IAR environment, or directly make a custom 
board pack from an existing Synergy board pack. IAR for EWSYN v7.71.1 does not have the option to use 
the built in Synergy export tool. and so use this approach to create the custom board pack. 

Follow these steps: 
1. Navigate to your SSP v1.2.0 or later; and go to the \internal\projectgen\arm\Packs folder of 

your packs installation for the IAR EW for Synergy. 
2. As shown in Figure 2, board packs that are already installed are listed there. 
3. Find a pack with the same or similar device as your targeted MCU, such as s3a7_dk, to make your 

conversion process faster. 
4. Pick a board name you want to use, such as s3a7_iot_enabler. Make sure to use that name throughout 

this process. 
5. Copy the board pack from step 3 and rename it with your board name. The board name must begin with 

“Synergy_board_”, such as “Renesas.Synergy_board_s3a7_iot_enabler.1.2.0.pack” for example.  
6. Extract the contents of this new pack file from a file archive utility, such as 7-Zip. 
7. Replace “s3a7dk.pincfg” file with your board name, “s3a7_iot_enabler.pincfg”. 
8. Modify the XML file in .module_descriptions. Replace all instances of the old board name “s3a7_dk” with 

your new board name “s3a7_iot_enabler”. 
9. Choose the part number in Device attribute as your targeted device. 
10. Rename the XML file to use your board name. Go to the synergy/board folder and rename the board 

folder “s3a7- dk” to be your board name “s3a7_iot_enabler”. 
11. To this newly renamed folder, add your BSP files, such as bsp.h, bsp_init.c, and bsp_init.h. You 

can make a copy from an existing board, and then manually modify it. 
12. Rename the *.pdsc file in the root directory of your new board. 
13. Modify the contents of the PDSC file: 

 Replace board name with your board name 
 Make sure there is a <file> element in the <component> for each file you want delivered as part of 

this pack. 
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14. Select all files and folders, then create a zip format of the file as 
Renesas.Synergy_board_s3a7_iot_enabler.1.2.0.zip, then change its name to 
Renesas.Synergy_board_s3a7_iot_enabler.1.2.0.pack. You must use a Zip software utility 
supporting the compression method DEFLATE, like 7-Zip (https://www.7-zip.org/) to create the file. 
Note that you should make the Zip file by selecting the .mcu, .module_descriptions, and synergy 
folders and the Renesas.Synergy_board_s3a7_iot_enabler.1.2.0.pack file. Then right-click 
and select 7-ZIP > Add to Renesas.Synergy_board_s3a7_iot_enabler.1.2.0.zip. 

 

 

Figure 48.   Create Zip Format File 

3. Conclusion 
Two different approaches for upgrading or creating a custom board pack for SSP v1.2.0 or later have been 
presented in this guide. By following the step by step instructions, users can recreate a pack for SSP v1.2.0 
or later from an existing custom pack in the SSP v1.2.0 or later, or create a new pack from scratch either by 
using a built-in Export Synergy User Pack or directly working on the files of a board folder.  

4. Known Issues 
While using e2 studio 5.4.0.23 for creating the Custom BSP from ground up, without using the board BSP 
and Board pin config supported by SSP, the user may run into issues when Export Synergy User Pack is 
used. Users need to change the file attribute from none to template. This issue is not seen in other e2 studio 
released for SSP v1.2.0 onwards. 

Note: By using the steps in the section 2.1 to create the Custom BSP, the user will not see the issue 
mentioned below. 

The snapshot of the attribute change required to create a Custom BSP using e2 studio 5.4.0.23 is shown in 
Figure 49. 

https://www.7-zip.org/
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Figure 49.   Attribute Change Required to Create Custom BSP in e2 studio 5.4.0.23 

5. References 
1. IAR Embedded Workbench, Getting Started with IAR Embedded Workbench® for Renesas Synergy™. 
2. Keil, CMSIS-Pack (v 1.4.1). Retrieved from Usage and Description: 

http://www.keil.com/pack/doc/CMSIS/Pack/html/pages.html 
3. Renesas Synergy™ Software Package v1.2.0 or later. 
 

  

http://www.keil.com/pack/doc/CMSIS/Pack/html/pages.html
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Website and Support 
Visit the following vanity URLs to learn about key elements of the Synergy Platform, download components 
and related documentation, and get support. 

 
Synergy Platform MCUs    Renesas Synergy™ Platform MCUs  
 Synergy Software Package    Renesas Synergy™ Software Package (SSP) 
 Software add-ons        Renesas Synergy™ Software Add-Ons 
 SSP Components          Synergy Software Package (SSP) Components 
 MCU Components          Components of Synergy MCUs 

Kits     Renesas Synergy™ Kits 
 Partner projects    Renesas Synergy™ Partner Projects 

 
Self-service support resources:    Renesas Synergy™ Support | Renesas 

Knowledgebase     Renesas Synergy | Renesas Customer Hub 
Synergy Community   Renesas Synergy™ Platform - Renesas Community 
Training    Academy | Renesas Synergy™ 
Videos     Renesas Synergy™ Platform - YouTube 

 

  

https://www.renesas.com/us/en/products/microcontrollers-microprocessors/renesas-synergy-platform-mcus
https://www.renesas.com/us/en/products/microcontrollers-microprocessors/renesas-synergy-platform-mcus/renesas-synergy-software-package
https://www.renesas.com/us/en/software-tool/renesas-synergy-software-add-ons
https://www.renesas.com/us/en/products/microcontrollers-microprocessors/renesas-synergy-platform-mcus/ssp-components
https://www.renesas.com/us/en/products/microcontrollers-microprocessors/renesas-synergy-platform-mcus/components-synergy-mcus
https://www.renesas.com/us/en/products/microcontrollers-microprocessors/renesas-synergy-platform-mcus/renesas-synergy-kits
https://www.renesas.com/us/en/products/microcontrollers-microprocessors/renesas-synergy-platform-mcus/renesas-synergy-partner-projects
https://www.renesas.com/us/en/products/microcontrollers-microprocessors/renesas-synergy-platform-mcus/renesas-synergy-support
https://en-support.renesas.com/knowledgeBase/category/30520
https://community.renesas.com/mcu-mpu/embedded-system-platform/
https://academy.renesas.com/?&formState=uHPQ4eQZt-FVWZp-xMG8iZkUOfEoAc2eP8WzW0cq0PeTblYCav1_CiTGsQ3lgLELzLcEcQ0DPDX1XGUXht3k2eSxt7amyEI_eFBlmiPHbf89wJA854lvfPYr0deYkYRU-rrMsJpLqylxlyGil2maxlmusbHMQveXfno4mTxCAmI77rxVemOv3G6M1e5EUNegBaGR5T0e1e9S8gucG7jV_OvsTj4GRV3cBIjTsyjOS0N39gW7IK7CKokANgXgDqxcRLHzf8s5pBT_3nqs9xKFFXSBe-FYnLaQOb0Gc4HQ8a1lJwdcbv0TPoHqTaqCqyF8ncymJ5dvrkL9y0mHyP8oQwH7s_T7tvX-gScaJQ6-taM%7C01
https://www.youtube.com/playlist?list=PLgUXqPkOStPu_uZCwn_1tM2QZIRDhcbCR
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product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use 
of these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, 
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 
or others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, 
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 
each Renesas Electronics product depends on the product’s quality grade, as indicated below. 
 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 
 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics 
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product 
that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but 
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 
specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 
responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 
subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.  
(Rev.5.0-1  October 2020) 

 
Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 
Koto-ku, Tokyo 135-0061, Japan 
www.renesas.com 

 For further information on a product, technology, the most up-to-date 
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